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To AQJS Staff

From Dalia Anan, Advanced Technology Officer
Ahmad Salem, Senior Network Engineer
Systems Research Egypt

Date  Thursday, 07 August, 1997

Subject AQJS Office LAN

This 1s to inform you that the AOJS office LAN 1s now operational, all features
and facilities presented to you during the training session are available
However some features of the original design are still not implemented due to
missing hardware and software components These will be installed as soon
as they arrive

The attached Manual Is intended as a guide to the use of the network, as well
as a bref introduction to the basic office automation and collaboration
applications

For further information please do not hesitate to contact us @ 3533827 and
3530880

Regards

|
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AOJS OfFICE NETWORK GUIDE

The main objective of this document is to acquaint users with the functionality
as well as the standards and conventions available on the AOJS office LAN
The guide describes the office layout, the various workgroups constituting the
office, the implementation of the network and the different tools and packages
installed on every computer It assumes knowledge of Windows95 and other
personal productivity tools The AOJS office LAN i1s designed to provide the
AOJS professional and administrative staff with an integrated, highly efficient

work environment

07/08/97 Systems Research Egvpt Page 3



AQJS Office Network Guide

NETWORK COMMUNITY

The LAN at AOJS serves the project staff which i1s divided into six
workgroups A workgroup is defined as a number of co-workers whose duties
and functions are closely related and interdependent At AOJS the following
groups are identified

Chief Of Party (COP)
This workgroup provides project leadership, monitoring and control function 1n
the project It 1Is made up of the following personnel

« Judge Ronald Taylor

s Monitoring & Evaluation Officer (TBD)

The Court Administration Workgroup
This workgroup provides court administration expertise and undertakes all
procedural re-engineering activities It hosts all the visiting short-term
consultants in this area It 1s made up of the following personnel

¢ Court Administration Expert — Mr Al Szahl

¢ Legal Expert — Ms Shamsnoor Abdel Aziz

The Court Automation Workgroup
This workgroup provides court automation expertise, and undertakes all
systems development and implementation management activities It i1s made
up of the following personnel

« Court Automation Expert — Mr Walter Kuencer

+ SRE Representative — Mr Sherif Hosni, SRE President

The Judicial Training Workgroup
This workgroup provides judicial tramning expertise and 1s mainly responsible
for NCJS strengthening activities It 1s made up of the following personnel

e Judicial Training Expert — Ms Virginia Leavitt

e Training Expert — Mr Sameer Sultan

The Project Office Workgroup
This group provides administrative support and financial control for the
project It 1s also responsible for all procurement activities It is made up of
the following personnel

¢ Project Administrator — Ms Janie Abel Aziz

e Accountant — Mr Gamal Kamel

e Translator— Ms Nadia Shaheen

* Receptionist — Ms Mona Rashwan

MOJ Coordinator
This group provides coordination with the Ministry of Justice It 1s made up of
the following personnel

e MOJ Coordinator — Judge Ashraf Kamal
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The following is a schematic diagram of the physical layout of the office
space

MOJ

Photocopying Coordinator

Ssultan

Room 06
Room 05 =4 Room 07

Kitchen
Conference

Room
Room 08

Gkamel

Room 04

Jabdulaziz

Room 09

SRE Wiring Closet
Representative

Reception
Mrashwan

Room 03

A\

Nmagdy

Rtaylor

Room 02
Wkuencer Room 10

Room 0
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NETWORK OVERVIEW

The network at AOJS s an Ethernet star topology It consists of a Compaq
Prohant 2500 server running under Microsoft NT Server v 4 connected to it
12 Windows 95 workstations where two of them can also work as NT
workstation v 4, in addition to the above, two portables are available for
mobile and remote computing A network printer and a network scanner are
connected to the AOJS LAN as well The current network domain at the
AOJS office 1s labeled "OA" which stands for Office Automation Other
networks might be added in the future to handle other tasks such as
development, Internet access, etc
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NETWORK SERVICES

The Local Area Network at AOJS I1s designed to perform integrated office
automation services All workstations in the office have

Desktops

The standard Desktop on the AOJS LAN s Microsoft Windows 95
Workstations used by bi-lingual members of AOJS will run the bi-lingual
(Arabic / English) version of the same operating system Windows 95 1s
installed in its default state, with one user profile per workstation

However, because of the special requirements of the Automation Workgroup,
their workstations will also run Windows NT workstation V 4 0 1n a second
partition with dual boot capability

Personal Productivity Applications

All workstations have MS Office 97 suite This provides personal productivity
capability of word-processing, spreadsheets, and presentations Some
Workstations also have MS Access Installed Again bi-lingual members of the
project have the Arabic enabled version of the office suite MS Office 97

Collaboration and Workgroup applications
The AOJS LAN provides all staff with a strong collaboration and workgroup
applications backbone, in the form of a central e-mail facility, and a workgroup
enabled Personal Information Manager (PIM) These two application provide
the following services
* |nternal e-mail
» [nternal Bulletin Board The Microsoft Exchange could be used to post
files to a public folder For example, you may want to post sales
projections or quarterly sales reports in a Microsoft Excel workbook so
the group can quickly view or record the latest information
= Electronic Forms 1s an easy way to distribute and collect information
electronically For example, a form can be available for anyone to order
office supplies or post information in a public folder
= Group Scheduling

Printing Facility
Users on the AOJS LAN have a very flexible printing facility providing, local,
workgroup and networked capabilities as follows
* Local Printing
HP 5L laser printers are attached locally to the workstations of some
members of each workgroup
» Workgroup Printing
Members of the workgroup can print on any printer attached to any
member of the workgroup
* Network Printing
All Members of AQOJS can direct their printing jobs to the Heavy-duty,
fast printer on the network
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Document Scanning

A combination of a Networked Document Scanner and a powerful Optical
Character Recognition (OCR) program provide AOJS with a flexible and
effective document scanning faciity All Long English documents can be
converted to digital files and distnbuted as e-mail However, Arabic
Documents can only be stored and distributed as images (no OCR)

Communications

The AOJS LAN provides a comprehensive communications capability to all
remote workstations through a specially configured multi port modem adapter
installed into the NT server When fully installed the AOJS LAN will provide
four networked modems and three local modems for backup In case the
server 1s down

Remote Access

Members of the project who are working at the courts or other locations off
site have the capability to connect to the AOJS LAN remotely and exchange
files or operate applications on the server

Internet Access

AOQJS has a compound account with RITE, one of the most efficient Internet
Service Providers (ISP) in Carro This account enables members of the
project to send and receive e-mail and browse the Internet

Mobile Computing

AOQJS members and visitors can use any of the two Compaq notebook
computers These notebooks are fitted with a multimedia docking
workstations and come with their own rigid carrying cases

Visitor Facilities

Visitors to AOJS who are carrying their own portables or using AOJS
equipment can log on the office network and use most of its facilities such as
emall, Internet access and extra storage and backup

I
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OPERATING ENVIRONMENT

AOJS local area network s designed to provide users with an integrated, easy
to use office automation environment It uses windows applications mostly
from Microsoft

Network Operating System - NOS
AQOJS LAN 1s based on Microsoft Window NT Server 4 0

Desktops

All workstations in the office operate under MS Windows 95 All by hingual
users are provided with the Arabic enabled version of the operating systems
Members of the Court automation Workgroup also have the ability to operate
under MS Windows NT Workstation 4 0

PERSONAL PRODUCTIVITY APPLICATIONS

MS Office is the standard personal productivity tool for AOJS This is also
supplemented by other products Such as Lotus Organizer, and Norton
Antivirus to enhance its capabilities

COLLABORATION AND WORKGROUP APPLICATIONS
A number of workgroup and collaboration applications are also provided 1n an
effort to simplify and streamline workgroup activities

The components of this environment are reviewed below in a little more detail
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DEsSKTOPS (OPERATING SYSTEM)

Ten Workstations at the AOJS are powered by Windows 85 The remaining
two workstations have Windows 95 1n addition to NT 4 0 workstation
installation

Win 95 workstation

The graphical user interface of Window 95 makes using a PC easier and
faster than before Windows 95 provides easy Internet access, multitasking,
and long file names And no worrnes about incompatibility Windows 95 not
only fully supports the latest, fastest productivity applications and multimedia
programs, it runs most Windows 3 x and DOS programs as well

Windows 95 operating system gives the user
* Fast performance and an easy-to-use interface
* Enhanced stability and protection
= A versatile platform for mobile computing
* The highest level of software and hardware compatibility
» A great way to get on the Internet

NT v 4 0 workstation

Windows NT workstation provides powerful performance and rehiability It
enhances productivity and reduces computing costs It Is easy to use, offering
the look and feel of Windows 95 The updated interface enhances usability
and efficiency, and includes the familiar Windows 95 Start menu, Explorer,
wizards, and interactive Help NT workstation provides efficient management
It includes remote management and troubleshooting tools for efficient
management and administration It embodies a performance monitor and
event monitor for local and remote troubleshooting

Norton AntiVirus

Because of pervasive problem on virus infection in large workgroup, AOJS
office LAN workstations are covered by Norton Anti Virus program It provides
the most complete and easiest protection tool for Windows 95 users |t
protects your data and your computer from almost all viruses Periodic
updates of this program will be downloaded to all workstations at the
beginning of every month
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PERSONAL PRODUCTIVITY APPLICATIONS
MS Office 97 (English / Arabic) contains the following

Microsoft Outlook Provides an integrated desktop where you can
organize and manage your e-mail, calendar, contacts, tasks, and files
In one place

Office Binder Stores all your files for a project in one place-you can
even add common headers and footers so they look and print like one
document Very useful in creating long reports created in different
Office applications

Microsoft Word Gives you everything you need to create
professional-looking documents, communicate your ideas, and share
information The Innovative new tools in Word 97 make it easy to get
powerful results

Microsoft Excel Breaks down the barriers of traditional spreadsheets,
making it easier than ever to analyze, report, and share your data

Microsoft Access Provides relational database power to give you the
information you need to make better decisions It integrates data from
spreadsheets and other

Microsoft PowerPoint You can easily organize, powerfully illustrate,
and professionally deliver your ideas

Organizer 97 Lotus Organizer 1Is a personal information and tme manager
for scheduling appointments, tracking to-do lists, maintaining address lists,
managing contacts and more Organizer 97 became somehow redundant
after the release of Outlook and Schedule+ as free components of MS
Office and MS Exchange It was ordered before that event
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COLLABORATIONS AND WORKGROUP APPLICATIONS

AOJS LAN provides members of the project office with two powerful
workgroup applications that enable them to exchange e-mails and e-
documents, also to schedule meetings and other group activities in addition to
sharing contact lists and other information

Microsoft Exchange 1t embraces Internet standards and extends rich
messaging and collaboration solutions to businesses It creates and manages
large mailing lists Once connected to the network at AOJS, you can send
mails to members of the same domain or on another domain, or Internet mail

Microsoft Schedule+ Makes it easier to manage calendars, tasks, and
contacts for yourself or share them within workgroups Scheduling workgroup
meetings Is also possible

|
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ADDITIONAL TOOLS & SPECIAL APPLICATIONS

Visio includes everything you need to manage and clanfy business
information through visuals, such as organization charts and block diagrams

ABC Flowcharter Powerful tool to draw flowcharts and diagrams

Microsoft Project it's a project management solution It makes project
management a natural part of your everyday business planning So you can
plan, manage, and communicate better to stay on schedule and on budget

CorelWPL 1t I1s a collection of products Itis used to convert any of AOJS
files that need to be sentto the States to the same format as the one used
over there

Microsoft Publisher Creates effective, high-impact publications Publisher is
exceptionally easy to use, so you can get creative nght away The program
offers so much design help PageWizard design assistants guide you
step-by-step to help you create all kinds of projects - brochures, newsletters,

flyers, Web sites, postcards, business cards, invitations, greeting cards,
labels, signs and banners, stationery and envelopes, calendars, business
forms, specialty items, and much more

pcANYWHERE32 Gives instantly access to data and applications from your
office computer or network, from home or on the road Quickly transfer files
from location to location or from laptop to desktop More over, you can dial
into your home or office PC and work just as if you were there Transfer files
from laptop to desktop Use office-based applications and edit documents on
remote machines pcANYWHERE32 will be installed on the two portables, in
addition to any other workstations possessing a modem
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MoBILE COMPUTING

The project has two notebook computers with docking stations that can be
used by members of the project or its visitors They can be connected to the
network, or used as stand alone computers They can also be carried by
AOQJS staff or visitors to pilot court locations (North Cairo and Ismailia) While
being outside the office they can remotely access the AOJS LAN using the
bullt in modem and a telephone line This will be accomplished using the
pcANYWHERE32

Notebook Specifications

Item Specifications
Model Compaq Armada 4130T
Processor Pentium 133 MHz
Memory 32 MB
Display 11 8 inch
Battery Two Batteries
Operating System Windows 95

Other Peripherals

ltem Specifications
Modem/Network Card Xircom Credit Card Ethernet + Modem
28 8
Docking Station 8x CD-ROM = One Battery
Portable Printer HP 320

Custody
The custody of these notebooks all their peripherals 1s with the project
administrator A simple procedure is used to obtain use by a member of the
project or by a visitor This procedure 1s as follows
»To take a unit

*Make sure that a unit 1s available

=Fill the appropriate form

*Test the unit to insure 1t 1s In good working order

s To return a unit
*Complete Section B of the form
aDemo unit to administrator
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NOTEBOOK ACQUISITION FORM

Name

Position

Purpose

Location North Cairo Court O Ismailia Court O
JiC a Home a

SECTION A

Date of Borrowing / /

Expected Date of Return

Is the docking station taken? |

Is the modem connection taken? |

Is the Network connection taken? ]

Signature of Borrower Signature of Project Admin

SECTION B

Is the modem connection brought back? %]

Is the modem connection in good state? |

Comments

Signature of Borrower Signature of Project Admin
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INTERNET ACCESS

AQJS uses RITE (Regional Information Technology Enterprise) as the
Internet Service Provider The following are active e-mall addresses

aojs@rite com
rtaylor@rite com
walter@rite com
virginia@rite com
aszahl@rite com

At the present time access to the Internet by all members of the AOJS project
is restricted due to the fact that communication server components (multi-port
+ modem sharing software) have not arrived yet Only workstation with a
physical modem installed can access the Internet

i
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VISITORS

AQJS office will often receive visitors on assignments Two possible patterns
have been identified either the visitor does not have his own machine and will
need to use the AOJS resources or he/she has his’/her own portable and
need to connect to the AOJS LAN In both cases, he/she 1s entitled to use the
AQJS resources and get connected to the LAN

Office Resources

A wvisitor who is not carrying his own portable can ask the Project
Administrator to be assigned the use of available computing resources
He/she may be asked to share one of the office workstations, or he/she
maybe given use of one of the office portable In either case the visitor
should contact the system administrator to issue a login name

Personal Resources

A wvisitor who s carrying his own portable and other penpherals can also ask
to access the office LAN so he/she can use other resources such as
exchanging e-malls, access files and backup his/her files on the server In this
case he/she must consult with the system supervisor on the hook up
procedure (Virus check, conformance to conventions, etc )

Issue visitor login name

Before the wisitor can access and use the network resources, he must be
assigned a user name and a unique password This is done by the System
Administrator immediately upon arrival Returning visitors can have their old
accounts reinstated All Visitor names will start with the letters Visitor and his
last name

Ex Visitor steelman

Privileges

Visitors can enjoy the following

Use of personal productivity applications
Personal Mail Box

Internet Access

50 MB personal space on the Server
Automatic Backup daily

Terminate

After the completion of the visitor mission, his/her account will automatically
expire If any of the AOJS resources was used during the visit, it should be
examined and returned In case of portables

Frequent Visitors

In case of frequent visitors, they will have their accounts always up and
running as well as a default folder containing all their work named after their
login name
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E-mail
If the visitor has an account with a service provider outside Egypt, he can

check his mall by first establishing a connection with RITE, then perform a
TELNET operation on his own server and check his mail He can perform this
either from the portable he owns (if he owns one with a modem) or from his
assigned portable, or from any of the three machines with the modem

Back-up
All work done by any visitor will be kept as a backup on the servern a

directory with the visitor name
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VisiTOR ARRIVAL/DEPARTURE FORM

ARRIVAL
Name

Login Name
Organization
Workgroup
Duration of Stay

e-mall address

OFFICE RESOURCES NEEDED

Workstation

Portable M

Printer M

OWN PORTABLE

Model

Operating System

AntiVirus Protection used

LAN Access

Backup

DEPARTURE

House Keeping Performed ]

Equipment Returned M

Signature of Administrator Date
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STANDARDS AND CONVENTIONS

All members of the AQJS office are represented as unique entities on the NT
network Some standards are set to easily identify each member

¢ User Name (Long on name)

User name is composed of two parts first initial and the family name Itis
used to logon to the network as soon as he/she puts the computer on This
same user name is used to denote the computer name While using the MS
Exchange, the address book shows all the available user names as well as all
the previously mentioned workgroups

AQOJS Member Name | User Name
Ashraf Kamal AKamal
Gamal Kamel GKamel
Janie Abdul Aziz JAbdulaziz
Mona Rashwan MRashwan
Ronald J Taylor RTaylor
Samir Sultan SSultan
Shenf Hosni SHosni
Shmasnoor Abdul Aziz Snoor
Virginia Leavitt VL eavitt
Alber Szahl ASzahl
Nadia Magdy NMagdy
Walter Kuencer WKuencer

e Visitor Names
Visitors will be assigned user names for the duration of their stay These user
names will be made nactive upon theirr departure  However If the same
visitor returns on another trip, his user name will be reactivated User names
will always start with the word <visitor> to be followed by a point followed by
the family name of the visitor
Ex  Visttor steelman

Visitor Feisen

e Default Folder

A default folder 1s created for every user on his computer , it is created on the
C dnive (the hard disk), with his previously mentioned user name While using
the MS Office (MS Word, Excel, etc ), any created document should be
saved under this default folder During the backup procedure, this folder is the
only one which will be saved on the NT server So it's recommended to save
all your important data and documents under this folder to facilitate the
recovery procedure in case of any damage or loss

Another folder 1s created on the server with the user name as well The user
Is automatically connected to this folder after logging in to the network The
network drive will be the F drive
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SECURITY

e PC Password
This secunty 1s done on the PC level Every user has to enter
password to Just access the PC

« LAN Password
Every AOJS user has a LAN password permitting him to check his
mail, to do the daily back up and to access his directory or files on the
server
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VIRUS PROTECTION

To overcome the spread of viruses at the AOJS office, Norton AntiVirus for
Windows 95 s installed on every machine All computers are now virus free
and the automatic protection featureis on The Norton AntiVirus is active in
the background, its icon could be seen in the tool bar and it's strictly forbidden
to close it as it should be active all the time If a virus is ever found, Norton
AntiVirus will guide the user through the process of eliminating it It's urged to
scan floppies before first use and make sure that it is not infected The user
can perform at his premises scanning of specific files, folders, or entire drives
for viruses In addition, Norton AntiVirus performs scheduled scans to run at
predetermined times The virus definition files contamning information that
Norton AntiVirus uses during scanning for known virus should be updated
every month This definition will be downloaded from the Internet every month
and installed on every computer to maintain the latest version
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START- UP PROCEDURE

Normal Start-up

When the workstation 1s powered up, a logon screen calls for the user name
and password to get connected tothe LAN Getting connected and remain
connected 1s essential as it permits to use the mailing system, MS Exchange,
MS Schedule+, and perform the daily back up

At the start-up, Norton AntiVirus is active in the background

Also, at the nght of the screen, a tool bar 1s hanging for easy access to
programs

The following applications will be opened on start up

MS Exchange Client

MS Schedule +

Start-Up After unplanned Shut Down

If any unplanned shut down happens, it's recommended to start 1s Safe Mode
by pressing F8 In the startup of the computer And In case of Registry
Corruption, also start in Safe mode and then shut down properly and start in
normal mode

Shut Down Procedures

Windows 95 is sensitive to the way it 1s shut down If it was shut
inappropriately  a registry corruption happens and a subsequent set of
problems occurs

Planned Shut Down

The BIOS will permit unattended shut downs So just click the icon to
backup and upon completion of the backup, click Start button, and
then Shut Down You don't have to watt, just turn off the monitor and
that's it

Unplanned Shutdown

If a power failure happens, so it's advisable to start in safe mode and
this by chicking on F8 durnng the start-up of the machine and choose
from the menu Safe Mode After logging In try to recover your
documents and restart the machine again but in the normal mode
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BACKuP

An 1con s created on every desktop called “Back Up" AOJS users are
advised to save all their documents under the previously mentioned folder
created on every workstation with their user name Upon mouse click of the
icon, all documents under this folder will be backed up on the server

It's worth to be mentioned here, that only newly created or updated files will
be backed up

RECOVERY

The network drive on the serveris “F" AOJS users will see a folder with their
user name containing all the documents that have been backed up daily Ifa
certain document 1s destroyed, the user can perform a simple copy and paste
from the network drive to his/her hard disk under the default folder

NETWORK BACKUP

A weekly backup s done on the server itself All the data will be backed to a
tape drive in case of any corruption to the initial data

PERSONAL ARCHIVING
|OMEGA ZIP DRIVE

lomega Zip Drive 1s another way to copy a bulk of data This drive can
accommodate data up to 100 MB

M
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SUPPORT

Help Desk

SRE will provide on site assistance and support until August 30 1997 After
that date SRE will provide telephone support from our offices in Maadi The
numbers to call are

Telephone 3533827

Fax 3530890

Mobile 0122163014

If the problem cannot be resolved through the help desk,

Problem Escalation Scenario

Users are expected to be familiar with the application programs they are
using They would have gone through the initial training program which would
have prepared them for ther work Stll support issues do anse We
recommend the following

Step one (RTM)

The user must be aware of his actions and the changes to the environment
This 1s essential as he/she has to report accurately to the support specialist

Step Two (Resident Support Person RSP)
An AOJS Well-trained person will be designated in the AOJS offices to
provide second line support

SRE
SRE will provide in depth support for AOJS users and visitors, the procedure
for this 1s as follows

SRE Support Specialist Ahmed Salem, Dalia Anan
Support Number s 3533827, ext 105, 106
Email danan@sre com eg

asalem@sre com eg
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SYSTEM ADMINISTRATOR SECTION
Care and feeding of Server

» Server ON/OFF

PowerChute provides orderly shutdown of the network file server in the event
of an extended AC power failure PowerChute prompts user notification of
approaching shutdown, power event logging, auto-restart upon power return,
and UPS battery conservation features PowerChute shows real-time
graphical displays of transient data such as battery voltage, UPS load, utility
line voltage, run time remaining, battery capacity, and battery voltage
PowerChute consist of two mail components The first 1s the UPS Monitoring
Module that runs as a background process It communicates with the UPS
and the User Interface Module, logs data and events, notifies users of
approaching shutdown, and when necessary, shuts down the operating
system The second is the User Interface Module gathers real-time data such
as UPS output, temperature, status

» |Insight Manager

Compagq Insight Manager 1s a comprehensive management tool to monitor
and control the operation of Compaq servers and clients Compaq Insight
Manager consists of two components a Windows-based console application,
and server or client-based management data collection agents

Working In conjunction with the hardware and firmware, the Insight
Management Agents monitor over 1,000 management parameters Key
subsystems are instrumented to make health, configuration, and performance
data available to the agent software The agents act upon that data, by
initiating  alarms in the event of faults, and by providing updated management
information, such as network Interface or storage subsystem performance
statistics With Compag Insight Manager, you have real control over your
systems, with monitoring and alerting capabilities for the cnitical systems in
the enterprise

»  Weekly Backup
A weekly backup i1s done regularly on tapes Tapes will be kept In case any
corruption happens to the AOJS files located on the server

» UPS

A UPS s nstalled and connected to the server In case of any power failure,
the UPS works for not less than 20 minutes giving the server time to
shutdown using PowerChute After power Is on again, the UPS starts the
server again
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WINDOWS 95
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GETTING STARTED WITH WINDOWS 95

In recent years, Windows has become a standard 1n the computing industry

The new Graphical User Interface (GUI) in Windows 95 has been designed to allow
users to access their programs and files visually

The GUI 1n Windows 95 1s appealing 3-D buttons and windows, color 1cons,

guide the novice through the system The Start Menu 1s the guide through all of the
programs and capabilities in the Windows 95 environment

If you are already familiar with Windows 3 1, Windows 95 contains many

of the features that you have taken the time to learn, such as double clicking, clicking
and dragging Other features have been improved upon and/or renamed File Manager
1s now replaced by Explorer, which functions 1n almost the same fashion

WHAT’S NEW IN WINDOWS 95

Windows 95 has some new and 1mproved features that will help you to work more
efficiently with your computer Here are some changes that you should notice

= Start Menu & Taskbar The Start Menu and Taskbar have been designed to
replace the Program Manager and its Program Groups

* Desktop The Windows Desktop now contains new i1cons called Shortcuts

» Explorer Windows Explorer 1s the new improved File Manager With 1t,
you can get a clearer view of your folders and files

* Network Neighborhood The Network Neighborhood 1s the tool to use
when you want to find a folder or file on another computer(if you have the
permuission to do it)

* Long Filenames In Windows 95 you can name your files with any length
filename even with spaces!

= Shortcuts Shortcuts are 1dentical to 1cons, except that they can be put in the
Start Menu or the Desktop

= Right Clicking Most items in Windows 95 can now be clicked on with the
right mouse button After right clicking on an item, a menu will appear with
options pertaining to what you clicked on

1 LOGINTO AOJS NETWORK

As previously mentioned the domain at the AOJS office 1s called “OA” standing for
Office Automation All AOJS members have to login to the network the first thing in
the morming after turming their computers on A dialog box appears with the last
logged user name on this machine For example Nshaheen, followed by a password
that the user has to provide and the domain name which 1s written by default “OA”
As soon as the password 1s verified by the network, the user will be connected to the
domain and has access to all network resources

If any user siis on a different machine than his own and wants to get access to the
network, he/she will have to provide his login name and his password on this
machine When the original user login the next time, he/she will have to write his/her
name again instead of the one provided

07/08/97 Systems Research Egypt Page 29



Application User Guide

2 START WORKING WITH WINDOWS 85

CoMPONENTS OF THE WINDOWS 95 DESKTOP

Start Menu Mimmzed Programs Taskbar System Tray

o MY COMPUTER

Contains all of the drives connected to your computer After double clicking on the
icon of My Computer, you will see a window that shows you 1cons for your floppy
drive, hard dnive, network drive, and any printers connected to your computer This
window also allows you to see any files and folders that are on these disk drives

» THE NETWORK NEIGHBORHOOD

Is similar to the My Computer 1con 1n that 1t brings up a window 1n which you can
browse files and directories However, the Network Neighborhood contains all of the
computers on the AOJS Network To connect to a computer on the network, you must
know that computer’s password or have permission to access 1t

e THE RECYCLE BIN
Holds all of the files that you delete until decide to empty 1t When the Recycle Bin 1s
emptied, the files are destroyed permanently

+ THE START BUTTON AND TASK BAR

Is where Windows 95 1s centered functionally Using 1t, you can start, minimize, and
maximize programs The Start button and taskbar are located at the bottom of your
screen when you start Windows 95 By default, they are visible when Windows 1s
running When you click the Start button, you see a menu which contains almost
everything you need to begin using Windows To switch between windows, just click
the button of the window you want When you close a window, 1ts button disappears
from the taskbar
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e THE START MENU
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“HStart EY Microsoft Word Windows

The Start Menu on the Taskbar 1s an easy and efficient way to access your programs
and settings 1n Windows 95 It 1s accessed by clicking on the Start button located on
the left hand side of the Taskbar After clicking the Start button, move the mouse
around the different menus until the desired program or function 1s found Then click
once on the title of the program you want to launch
Programs
The Programs menu holds all of the applications that come with Windows
85 or are installed on the computer such as Microsoft Office
Documents
The Documents menu holds Shortcuts to documents that you have
recently opened in applications
Settings
The Settings menu contains the Control Panel, Printers Folder, and
Taskbar options
Help
Help 1s the famihar help program that can now also be accessed through
the Start Menu
Find
With this option, you can choose to search for files and folders on your
computer
Run
This option allows you to specify a program to run if it does not have an
entry in the Programs menu
Shut Down
Before you turn your computer off, Windows 95 needs to save changes
and close certain files It 1s very important to use the Shut Down command
before you turn off the computer

MANIPULATING WINDOWS
All programs in Windows 95 are run within windows, or boxes that have similar
properties
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* Minimizing

To mimmize or shrink a window, click on the first button in the right hand
corner It has a bar symbol on 1t because when minimized, a program will
appear as a button on the Taskbar

* Maximizing

To maximize a window, click on the button with a box on 1t The window will
then fill the entire screen

* Restoring

To restore a window to an 1n between size, click on the button with two small
windows 1n 1t

* Closing

To close a window, click on the button with the X on 1t If the window 1s a
program, closing 1t will quit the program

* Moving

To move a window, clich on the title bar and hold the mouse button down

Then drag the window to where you want to position i1t

» Scrolling

The scroll bars indicate that there are items that are not currently visible on
the screen To scroll through, move the cursor to one of the arrows and click
the mouse button The 1nside of the window will move to reflect the change

e OPENING A DOCUMENT

There are several ways to open documents in Windows You can open your document
from within the program you used to create 1t Or using the Documents command on
the Start menu to open adocument you have opened recently Also, you can use the
Find command on the Start menu to locate the document 1f you just know its name or
date of creation

» GETTING HELP

There are two kinds of Help Help about a specific procedure and Help that gives you
information about what you see on your screen You can access Help by clicking the
Start button and then click Help, you will find a list of help topics You can use the
tabs 1n Help to search for information 1n several ways For information about an item
1n a dialog box, click the item , and then click the item
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s THE CONTROL PANEL
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The Control Panel allows you to change how your computer looks and operates To
open the Control Panel, choose Settings, Control Panel from the Start Menu The
following window will appear Using Control Panel, you can change the way
Windows looks and works Click the Start button, and then pomnt to Settings, then
click Control Panel Double click the Display icon to see the settings you can change
You can change the background color of your screen, the screen saver, the

appearance, etc

The most commonly used options 1n the Control Panel are

Add New Hardware
Add/Remove Programs

Date/Time
Display

Fonts

Mouse
Multimedia
Network
Passwords
Printers

Regional Settings

Adds new hardware to your system

Sets up programs and creates shortcuts

Changes date, time, and time zone information
Changes settings for your display

Views, adds and removes fonts on your computer
Changes settings for your mouse

Changes settings for your multimedia devices
Configures network hardware and software
Changes passwords and sets security options
Add, removes and changes settings for printers
Changes how numbers, currencies, dates and times are
displayed

Sounds Changes system and program sounds

System Provides system information and makes advanced
changes
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e SETTING COLORS

Windows provides several pre-defined color schemes Colors for your Windows
screen can be changed by clicking on the Display option and choosing the Appearance

tab
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To select anew color scheme, click on the Schemes pull down menu After choosing
a new scheme, the preview will change to show 1t If you want to change your colors
to the new scheme, click the OK button If you want to change the colors of individual
components of a window, use the [tem pull down menu and then choose a new color

from the Color pu

1} down menu

e SETTING A SCREEN SAVER
A screen saver 1S a program that displays moving graphics or words on your screen
when you are not working In order to choose a screen saver, choose the Display

option from the C

ontrol Panel and then choose the Screen Saver tab
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Displaj Properties

b .a_—__\« . moms e STia o St

g~ “Backgiound SCfeen Saver ] gppearance] F'[usl - Settmgs]
W‘ —v

S

e et -
B ST Ao e capsaum i i1 BIVESRL N SN
peptey 3 é - =S R g
= ® s o S T SR
- — T
o T 3 F - i e
-~ [ » -
P ~dE v e R
T W AR ) 1 i T - S
3o kol e —
S S "1‘\;“ T e L
e T mw Fhd - -.T
T % ﬁ:ﬂ - e -
- [ E~ T LemT o
SR L
e = A
l [ - 3 + - T - e
R e - s
ERE 1;1 = . Wy F R
I ~iE = -4 T
. =
1{'}" “ ;g . ;o 7; :":::.ii.
s - LG e
e, - TE
N i
R R I
oo o= - - &
" T Screen Saver === -3
L =
i ’ m Youernd ]" _Settngs - ] ey F’rewew - 1
Sz =5 ”Jme‘hkae‘.\”"'” d - :.,:
- T e — -
- -
- I- Password prolected = Chenge l Wall 15 3, minutes « | ~
o PR 1 - [ T
_: = ,m:v-‘,r'v e e Yt TR T ST S e TS T e -
- = T, e P gTn L v =T e 4 .3
w mown e T A N SR e T o o= =
g W s & ) — - - -
— Py L £ R SN L - o - P -
W D « - - T e z -
o - bt - - -~ - bt - e -
! - . - :m - \;i - ! - s
i d - I . v -
[ i - -
' TR e e T e am " - -
T Trnerrea ow L R T Sl SO g T 3 - A
. = = - =
¢ e e—— o
w » e e J— - - BN amresaay 4 T R -
. g 2 - H
ey e wame 20K T Concel Apply

Use the Screen Saver pull down menu to choose a screen saver The example screen
will show you a preview If you want to see a full screen preview, use the Preview
button If there are settings that you want to change for the screen saver, use the
Settings button The Wait prompt allows you to change the time 1t takes for the screen
saver to start after no work 1s being done on the computer

e SEEING WHAT'S ON YOUR COMPUTER

Double chick My Computer icon appearing on your deshtop A windows appears
displaying several pictures, like for example the 3 ¥ floppy, your hard disk, the CD
drive and the network dnve where you back-up your work daily If you double click
any of these icons, you get the content of each rtem

To see the hierarchy of folders and documents, click the Start button, point to
programs, and then click Windows Explorer The screen you will get 1s divided into
two partition the disk drives and folders appear to the left, and to the right side, the
contents of the item you click on the left are displayed In Explorer, you can browse
both the hierarchy of folders on your computer and all the files and folders in each
selected folder Explorer 1s very similar to File Manager 1n 1ts functionality
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To start Explorer, click the Start Menu, and then point to Programs

Each 1tem on the left hand side of the Explorer window represents its counterpart on
the Desktop The items on the nght hand side of Explorer represent the contents of the
selected 1tem on the left Therefore, 1f you want to see what 1s on your hard drive,
click on the plus sign beside the entry that has C beside 1t The list will expand to
show all of the folders in 1t Click on a folder to see its contents

12X Exploring - My Computer - - -
& File Z Edit* View Tools. Help ™ & x 7 =2 by oo’ S e g g -
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e ORGANIZING FILES AND FOLDERS

To move or copy a file or folder, find the file or folder and then click 1t, click Edut, to
move the file, click Cut and make a copy of the file, click copy Open the folder
where you want to place the file, click Edit, and then click Paste To Delete a file or
folder, click 1t and then trom File menu, click Delete The files you delete are put 1n
the Recycle Bin, a holding place for files you no longer need They are not actually
removed from your hard disk until you “empty” the Recycle Bin

s TO CREATE A NEW FOLDER

For example, in Windows Explorer, double click the disk drive or folder in which you
want to place the new folder, on file menu, point to New, and then click Folder Type
the name of the new folder, and then press Enter

e TO COPY AFILE TO A FLOPPY DISK

Find the file or folder you want to copy, on the File menu, point to Send To, and then
click the drive where you want to copy the file or folder You can copy or move a file
also by dragging In Windows Explorer, open the folder that contains the file you
want to move or copy Use the right mouse button to drag the file to the folder where
you want to move or copy 1t Then release the mouse button Then click Move Here or
Copy Here You can also move or copy a file by dragging 1t using the left mouse
button Dragging a file between two folders on the same drive moves the file

Dragging a file between different drives copies 1t instead

g
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e COPYING MOVING AND DELETING INFORMATION

Before editing any imformation, you must select (highlight) it Place the mouse pointer
where you want to start selecting Then press and hold down the mouse button, and
drag the pointer to where you want the selection to end Then release the mouse
button To copy or move information, first, select the information Click Edut, to leave
the information where 1t 1s and take only a copy of it, click Copy In the document
where you want to insert the information, click the place where you want 1t to appear
On the Edit menu, click Paste

e CREATE A SHORTCUT ON THE DESKTOP

Shortcuts provide easy access to the documents or programs that you use frequently
In my Computer or Windows Explorer, locate the item you want easy access to Use
the right mouse button to drag the item to the desktop Then release the mouse button
Click Create Shortcut Here

The tool bar located on every desktop at the AOJS office has shortcuts to all Office 97
components plus Windows Explorer, Norton Antivirus and Lotus Organizer

e SHARING FOLDERS WITH OTHER COLLEAGUES

To share a folder, locate the folder or file you want to share and then click it On the
File menu, click Sharing, Click the options you want Once the file 1s shared, 1f you
take a look at 1t in the Windows Explorer, you will find a blue hand holding the folder
meaning 1t’s a shared file or folder

e USING A SHARED FOLDER

Double click Network Neighborhood Double click the icon for the computer that
contains the folder you want For example, if the file 1s located on Janie’s computer,
you click the computer named Jabdulaziz Double click the folder that contains the
document or program you want

e PRINTING
There are three types of printing allowing AOJS members to select from according to
their needs

e Local Printing

Users with a laser printer connected to their PC will be able to print any file
locally This 1srecommended for short documents only Longer document s
(5 or more pages) should be printed on the network printer

* Workgroup printing

Each workgroup 1s provided by a light duty laser printer (HP LaserJet SL) It
1s usually located on the desk of the expatnate counterpart, and attached to his
workstation Members of the same workgroup can print small documents,
memos, drafts etc

» Network printing

Users can print large documents using the network printer as long as they are
connected to the NT server In case of very large documents, users are
encouraged to print on the network printer for fast and high quality output

07/08/97 Systems Research Egypt Page 37



Application User Guide

Steps to follow 1n order to print 1n either case

To print the document , select File menu Print and then select from the list the
appropriate printer type according to your needs

Note It should be mentioned here that each member of the AOJS will have
only two options of printing either local and network, or workgroup and
network printing

* MAKING YOUR WORK MOBILE

Sometimes you might work on the same document both at home and at the office, or
use a laptop computer when you travel Now it 1s easy to keep multiple versions of a
file in sync with each other Just use Briefcase located on your desktop

e SHUTTING DOWN YOUR COMPUTER

To quit Windows and shut down your computer, click the start button, and click Shut
Down Click Yes and then a screen message lets you know when you can safely turn
off the computer
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NORTON ANTIVIRUS
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« OVERVIEW OF NORTON ANTIVIRUS

Norton AntiVirus 1s the one of the most sophisticated and powerful product available
to safeguard your computer from virus infection, no matter what the source You will
be protected from viruses that spread from hard or floppy disks, viruses that travel
across networks, and even viruses that are transmitted across the Internet

Here's what Norton Ant1Virus does automatically

Checks system files and boot records for viruses at system startup
*Checks programs for viruses at the time you use them
»Scans your startup drive for viruses once per week
=Monitors your computer for any activity that might indicate the work of a
VIrus in action
*Checks floppy disks for boot viruses when you use them

Here's what you can do with Norton Ant1Virus

= Scan specific files, folders, or entire drives for viruses

»Schedule virus scans to run at predetermined times

*Update virus definitions files monthly

*Customize Norton AntiVirus protection to match your risk level of virus
infection

How 1O

¢ TOFIND VIRUSES ON YOUR COMPUTER

Check one of the following options

*Initiate virus scans at any time by choosing which drives to scan and cliching
Scan Now in the Norton AntiVirus (NAV) main window

*Use the Scan menu in the NAV mamn window to choose specific files or
folders to scan

»It 1s advised that you always scan disks before you use them or when
downloading files from bulletin boards

=Schedule scans regularly

= eave Auto-Protect enabled

=Update your virus definitions regularly

e TOINITIATE SCANS

*Open the Norton Ant1Virus main window 1f 1t 1s not already displayed

*Choose one of the following options

0 Check a drnive or drives in the Drives list box or check a category of drives
in the Drive Types group box and click Scan Now
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a The All Network Drives option 1s dimmed 1f you are not connected to a
network or if Norton AntiVirus 1s configured not to allow network drive
scanning

o Click Folders from the Scan menu, select the folder, and click Scan

o Chick File from the Scan menu, select the file or type 1n a filename, and
click Open
0 The Scan dialog box reports on the progress of the scan

e TO ALWAYS SCAN FLOPPIES (DURING SCANS YOU INITIATE)

*Click Options 1n the Norton Ant1Virus maimn window

»Click the Scanner tab 1f 1t 1s not already on top

*Click Advanced at the bottom of the tab

*Check All Floppy Drves in the Preselect At Start group box and click OK to
save settings and exit the dialog box

*Click OK to save settings and exit the dialog box

Note If you performed a complete setup of Norton Ant1Virus and accepted
all recommended options, Auto-Protect scans floppies at startup and when they are
accessed What you are setting here simply means NAV will also always scan floppy
drives when you 1nitiate a scan

e TO SCANDRIVES

*Open the Norton Ant1Virus main window 1f 1t 1s not already displayed

»Check specific drives to scan in the Drives list box or select multiple drives at
once by checking one or more options 1n the Drive Types group box and click

Scan Now

The All Network Drives option 1s dimmed 1f you are not connected to a network or 1f
Norton AntiVirus 1s configured not to allow network drive scanning

o TO SCAN AN INDIVIDUAL FILE
»Click File from the Scan menu
=Select the file you want to scan
*Click Open

« REMOVING VIRUSES

There are two ways to remove a virus from your computer

»Repair the infected file, boot record, or master boot record
*Delete the infected file from the disk and replace 1t with an uninfected copy
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You should not leave an infected file on your computer NAV can repair most
infected files However, in the case that a file cannot be repaired, you must delete
it from your disk You need to get into the habit of keeping original disks in a safe
place and making backup copies of your files If you do not have an uninfected
backup copy of a file, the original program disk, or online access to the file, you
need to get a new copy of the file from the software manufacturer
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Note that Norton AnfrVirus also scans Microsoft Word documents ( doc and dot)

when scanning program files Although these are not program files, they do
contain code and can be infected by a new class of viruses called Macro Viruses
Therefore, some of your data files are now at risk You need to mahke backup
copies regularly

That’s why all users are urged to perform the backup procedure by clicking on the
backup 1con located on their desktops before leaving each day
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MICROSOFT EXCHANGE

07/08/97

Systems Research Egypt

Page 43



Application User Guide

GETTING STARTED WITH MICROSOFT EXCHANGE

e OVERVIEW OF THE MICROSOFT EXCHANGE CLIENT

With the Microsoft Exchange Client, communication and sharing of information with
other people mn an effective and timely manner became a reality It enables easy
sending and receiving of mails, organizing, and sharing information, regardless of its
location or format

When the user opens the Microsoft Exchange Client, he/she can see the Viewer, the
window to information The left side of the Viewer displays sets of folders, and the
nght side displays the contents of the selected folder From the Viewer, the user can
send and receive mail, organize and manage information, and access and exchange
information with other users

e SENDING MESSAGES

The user can send messages that include formatted text, inserted files and objects, and
an AutoSignature In addition, he/she can

¢ Address a message by selecting names from the Address Book
o Check spelling before sending a message
e Assign mmportance to a message (normal, high, or low) and request an
automatic delivery notification
o Keep the message secure by signing 1t, sealing 1t, or both
o Use forms created by people in the AOJS for specific types of information,
such as a phone message or an expense report
Tips
It 15 recommended to use the formatted text internally (I mean inside AQJS)as
sending formatted text through the Internet fails cause the recipient might be using
different mailing system

o SHARING INFORMATION AMONG TEAMS AND ORGANIZATIONS

In addition to sending and receiving mail, the user can access and exchange
information 1n public folders Unlike the user mailbox or personal folders where
he/she stores information for his/her own private use, public folders provide an easy
and effective way for multiple users to collect, orgamize, and share information
Because public folders are centrally located on Microsoft Exchange Server computers,
users always have access to the most up-to-date information

Public folders can be designed and customized to meet specific needs For example,
you might use a discussion folder to discuss new 1deas
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o ORGANIZING AND MANAGING INFORMATION

Folders provide the basis for organizing information The contents of any given folder
can range from e-mail, simple text files, and faxes, to documents, meeting requests,
and forms The user can place all types of related information 1n a single folder
regardless of where i1t was created There are three types of folders mailbox folders,
personal folders, and public folders

o MANAGING INCOMING MAIL WHILE OUT OF THE OFFICE

If the user 1s going to be away from the office, he/she can use the Out Of Office
Assistant to notify the people who send him/her mail The Out Of Office Assistant
sends a message to each sender only once

The user can also create rules that are performed only when the Out Of Office option
1s on For example, he/she can forward a copy of each high-priority message that
he/she receives to another person

Basic CONCEPTS AND FEATURES
e« STARTING THE MICROSOFT EXCHANGE CLIENT

When the Microsoft Exchange Client 1s started, the Viewer 1s displayed The Viewer
1s your window to information the central location in the Microsoft Exchange Client
where you send and receive electronic mail (e-mail), organize information, and view
Schedule+ meeting requests The left side of the Viewer displays folders, and the right
side displays the contents of the open folder The following figure shows the contents
of an Inbox displayed in the Viewer

l—- Menu names l—T oolbar

R e - Inbox - Microsoft Exchange - - .- oo
File Edit View Tools Compose Help :
= ST e FREETR
Bje & SEX] sl malwelE gl T2 0
€8 Microseft Exchotge | [N BRG] From= =572 "o | Subject= - =75 2.

& 3 Malbox AnnDevon | ¥ 84 (] Murray Sodetholm  Customer feedback .
@ Delcted Items B4 § Melnda Overmiwe  status report '
| ~@ Inbox [4) B Yoshi Latimer Reminder staff meeting |
Outbox ™  Fran Wilson Customer feedback !
- Sent ltems 3™ RonaRumalsk: Volleyball tomorrow @ 700
) Personal Folders i P4 Jame Yores Proposed product changes |
L= 3 Public Foldrs i P2  FranWison b1 Roliout Strategy :
C:l Favontes ; e — T '
___m 1 AlPuble Folders 161~ — : RN
7ltems=4 Untead =5 - = "o Mo T a2 T 2. T Rz B et B
L Folder list Folder contents list -

*  Menu names
The menus contain all the Microsoft Exchange Client commands Choose a
menu name to display 1ts commands
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= Toolbar

The toolbar provides buttons to perform common tasks To find out what a
toolbar button does, position your pointer over the button for a moment, and a
ToolTip will appear

*  Folder list
The folder list 1s the location where you access your mailbox and folders It
includes the following items

*  Mailbox

The location on a Microsoft Exchange Server computer where your mcoming
and outgoing mail 1s delivered Mail includes messages, forms, and other
items Your mailbox contains Inbox, Outbox, Sent Items, and Deleted Items
folders You can create additional mailbox folders to store messages and other
1tems

*  Personal folders

A set of folders that you have created These folders are stored in a file that 1s
typically located on your hard disk You can create a set of personal folders to
back up or archive folders, store related messages, forms, and files, and work
with 1tems remotely You can also designate a set of personal folders as the
delivery location for your incoming mail

*  Public folders
Folders that you and your co-workers can use to share a wide range of
information This feature 1s available only with Microsoft Exchange Server

*  Favortes

Your personal view of the public folder list You can add public folders that
you frequently use to your Favortes folder and then access them from there
instead of looking through the entire list of public folders

»  All public folders
The entire list of public folders

*  Folder contents list
The folder contents list displays headers of items contained 1n the open folder
Unread items appear 1n bold To open an 1item, double-chick 1t

e SETTING OPTIONS FOR YOUR MESSAGES

When sending messages, the Microsoft Exchange Client provides you with a variety
of options The options you choose can vary, and can be applied to a specific message
or to all messages Some of your options are

Formatting text by choosing fout types, font sizes, and colors
Inserting files and objects into messages

Saving copies of messages

Assigning high or low importance to messages
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Requesting a Delivery or Read Receipt so that you know when a message
has been delivered or opened

Signing messages with your AutoSignature
Checking the spelling in messages before sending

[ [ElamIE e

T ————

. . T T e = =

| ‘Tg"'fg{Ann Devon : ha
— vmowre 3
eS| -

Subjec’c lSample Message

i Y
You can formst your text In & message by L
+ creating a bulleted list

+ using cifferent fort types, siyles, and S12€5S
s applying colors!

You can slso Insert objects and files into Your messages B
10% 0% -
40% 4
E
2
30% o
REPORT DOC
Complete your message with your &utolignature, pomm
(&ii M g
+
R e - "4

¢ LOOKING UP NAMES AND INFORMATION IN THE ADDRESS BOOK
The Address Book 1s a directory of address lists containing user names, distribution
lists, and public folder names You can use the Address Book to address messages and

get information, such as a phone number or job title You have at least two address
lists 1n your Address Book

+ A global address list

» A personal address book (PAB)

The global address hist contains the names of all Microsoft Exchange users and
distribution lists that you can address messages to Your PAB 1s acustomizable
directory that you create Your PAB can contain any kind of address that you choose
to add names of people to whom you frequently send mail, personal distribution lists
(PDLs), or custom addresses of users of other mail systems, such as the Internet If
you work offline, you must have a PAB

07/08/97 Systems Research Egypt Page 47



Application User Guide

¢« FINDING INFORMATION

As you create folders and add information to them, you may find 1t necessary to
search for specific items from time to time Using the Find command on the Tools
menu, you can easlly search for items that meet specific conditions

¢ ORGANIZING INFORMATION USING FOLDERS

You can create folders in your mailbox or in a separate set of personal folders to store
and organize information The contents of any folder can range from messages, text
files, and faxes, to documents, spreadsheets, meeting requests, and forms You can
place all types of related information 1n a single folder, regardless of where 1t was
created

messages
s form

ﬁ spreadsheets
fﬁ-j dotumends

(98] meetny requests
In general, 1t 15 a good practice to keep messages short and concise Long "walls of

text” 1n mail are difficult to read and may indicate a subject that would be better dealt
with erther 1n a printed memo or 1n person

How ToO
¢ TO SEND A MESSAGE

1 In the Viewer, choose New Message from the Compose menu, or click the
New Message button

—

=

2 To address the message, do one of the following

Click To or Cc to select names from the Address Book
In the To or Cc box, type the names of the primary recipients and users whom
you want to recelve a carbon copy Separate multiple names with semicolons

()

If you want to send a message to one or more users as a blind carbon copy,
choose Bcc Box from the View menu Then, click Bec to select names from
the Address Book, or type the names of the users whom you want to have
recelve a blind carbon copy 1n the Bee box

3 Inthe Subject box, type the subject of the message
4  In the message body, type your message
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5 From the File menu, choose Send, or click the Send button

=S¥
P

Note By default, all messages that you send are automatically saved 1n the
Sent Items folder

= - “Test message - Microsoft Exchange . - "
Eile Edit Yiew [nsert Format Iunls Compose H

s [EmEEEAEEEE]E
I%Ts:igﬁour Name . 3}%]
l-.,Cc ~ E] =

,Subject ITest message }Z_

e S e Ao B o g FoF == prrrgiend

This 1s a test message | m learning how to i
» Address, format and send a message
» Openamessage

. Reply toa message]

+
o T - e s /
u‘:.,*«:.a..»m,.._ o » - W & o T e - ~ )

TO OPEN A MESSAGE OR OTHER ITEM IN A FOLDER
Messages that are sent to you are listed in your Inbox When a message sent to
you arrtves m your Inbox, the header appears in bold, indicating that you
haven't read 1t

o Double-click the header of the message, or select the item, and then choose
Open from the File menu

L ]

TO OPEN THE NEXT OR PREVIOUS ITEM IN THE LIST, DO ONE OF THE FOLLOWING
WHILE AN ITEM IS OPEN

e To open the next item mn the list, choose Next from the View menu
e To open the previous item 1n the list, choose Previous from the View menu

ToO CLOSE AN ITEM
¢ From the File menu, choose Close

L ]

TO REPLY TO A MESSAGE OR TO FORWARD IT

1 If the message 1s not open, you must first select it Then, do one of the
following
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Toreply Do this

e To the sender only From the Compose menu, choose Reply To Sender, or
click the Reply To Sender button

—_—

o

¢ To the sender and everyone listed 1n the To and Cc boxes From the Compose
menu, choose Reply To All, or click the Reply To All button
=

e You can also forward a message to another user by clicking the Forward
button
[oe]
2 Type your reply
You can also insert comments in the original message text
3 From the File menu, choose Send, or click the Send button
e TO DELETE A MESSAGE OR OTHER ITEM

If you are working 1n a public folder, you must have Delete Items Permission to
delete an 1item

From the File menu, choose Delete, or click the Delete button

If the 1item 1s closed, you must first select 1t

Tips

To delete a list of sequential items, select the first item 1n the list, and while
pressing SHIFT, press the down arrow key until you reach the last item that you
want to delete

To delete 1tems 1n a list that are not sequential, select the first item 1n the list, and
while pressing CTRL, click each item that you want to delete

e

>4
¢ TO INSERT FILES OR ANOTHER MESSAGE IN THE ORIGINAL MESSAGE

1 Click the New Message button, fill the To and Subject fields From the
menu [tem Insert choose either File or Message

Tips

¢ Internet mail It 1s recommended that you type the Internet mail that need to be
sent via modem and Internet connection to Ms Mona Rashwan in Text Format
using Note Pad or Word and save the document as Text

e In case of sending internally Word document to any AOJS members, take into
consideration that the bi-lingual group has MS Office 95 and 1s not able to
open MS Office 97 documents So the MS Office 97 group has to convert the
document first to the Office 95 format before printing
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e TO SIGN A MESSAGE THAT YOU ARE COMPOSING

1 From the View menu, choose Toolbar

2 When you finish composing a message, click the Sign button

3 Click the Send button

4 In the Password box, type your advanced security password, and then choose
OK

o TO SIGN ALL MESSAGES THAT YOU SEND

1 From the Tools menu, choose Options, and then select the Security tab
2 Under Options, select Add Digital Signature To Message, and then choose OK

Important If you are composing a message and set this option using the Tools menu,
the option will not be applied to the active message It will be applied to all future
messages

e TO SEND AN OUT OF OFFICE NOTIFICATION TO PEOPLE WHO SEND YOU MAIL

1 From the Tools menu in the Viewer, choose Out Of Office Assistant

2 Select I Am Currently Out Of The Office

3 In the AutoReply Only Once To Each Sender With the Following Text box,
type the message you want to send to others, for example, "Out of the office until
the tenth of this month "

4 Choose OK

Note When you log on to the Microsoft Exchange Client with the Out Of
Office Assistant turned on, a notice 1s displayed to remind you to turn 1t off

e TO GET TOOLBAR BUTTON INFORMATION

Position your mouse pointer over the button that you want information about
Microsoft Exchange displays a ToolTip that briefly describes that button

e WORKING WITH FOLDERS

Once you begin recelving messages, you'll want to organize them so they'l] be
easy to find later You can create folders and subfolders (folders within a
folder) for orgamzing and storing related information

e CREATING FOLDERS
When you create a folder, 1t appears as a subfolder of the open folder
1 Click your mailbox

@ Microsoft Evchange
=) @ Maibox AnnDevon

From the File menu, choose New Folder

Type the name of the new folder
4 Choose OK

W N
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5 The Status Reports folder appears as a subfolder of the mailbox If you did not
select the mailbox, Status Reports would have been created as a subfolder of the
open folder

e MOVING MESSAGES TO OTHER FOLDERS

The easiest way to move messages from one folder to another 1s by dragging them

1 Click the Inbox to display the message you sent to yourself

2 Drag the message to the Status Reports folder, which you created 1n the previous
procedure

You can also move or copy a message by selecting it and then choosing Move or
Copy from the File menu

e EXPANDING AND COLLAPSING FOLDERS

If you create subfolders, there will be times when you want to display or hide them
To expand a set of folders, click the plus sign (+) next to the parent folder name

=3 Malbas AnnDzvon

To collapse a set of folders, click the minus sign (-) next to the parent folder name

B &3 Malbox AnnDevon
7{:}‘ Deleted ltems

&J Inbox
Outbox
[Z] Sent ltems
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MICROSOFT SCHEDULE
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GETTING STARTED WITH MICROSOFT SCHEDULE

o QOVERVIEW OF THE MICROSOFT SCHEDULE

Microsoft Schedule+ 1s an easy-to-use orgamizer that helps keep track of schedule and
contacts Microsoft Schedule+ 1s a time-management tool that allows you to manage
your schedule, tasks, and list of contacts, and coordinate your schedule with others

With Schedule+, the user can
= Track appointments
= Schedule meetings with other Microsoft Exchange Client users
= Priontize tasks on your To Do list
» QOrganize business and personal contacts
= Set reminders to help you remember your appointments, meetings, and tasks

Schedule+ arranges information on different tabs These tabs let the user sees his/her
schedule, To Do list, contacts, and other information in several different ways By
default, Schedule+ displays the Daily, Weekly, Monthly, Planner, To Do, and
Contacts tabs Depending on the details the user need to know, he/she can add and
remove tabs so that Schedule+ displays nformation in the arrangement that works
best for him/her

- ~ -Ann Devon - Microsoft Schedule+ = == 70 0y
File Edit Yiew Insert JTools Help

[Tosy B 2(B] £ [ml@] S| A 2S

2| S taioher 1986 < L EELS [ T 'o"a;?ensaé =T

& wET T

,2, “ﬁ”’*ﬁ ey ._.4*—:; Fn.q,* awt—r-?;q:-kw-\l*‘jr —S WM-~T W T F S N

=9
@
)

.y = -
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-'—g #4730 :I,: ;W
S Tl 2 My Office 3 || [ Fessiorenhardyore:
= 2.2 3g[lfIntetview new 1ob candidate #||12] . Resolve package issue
wY | N =
=4 eto0] © T | | 2| Frenewisesaste—
;:_j 3% gg = - Update schedules _‘_{,}
2L 1 #

‘;{Zék 5. 00 = ——— - 14
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When you start your computer, Schedule+ 1s automatically activated You can also
start Schedule+ from the Microsoft Exchange Client by cliching the Schedule+
toolbar button 1n the Viewer When Schedule+ 1s started, the Schedule+ window 1s
displayed The Schedule+ window includes a menu bar, a toolbar, a status bar, and
one of several views of your schedule Use the tabs on the left of the Schedule+
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window to switch between views Each view consists of one or more of the following
In various arrangements your daily, weekly, or monthly schedule, the Planner, the
Date Navigator, the To Do list, and the Contacts tab When you first open Schedule+,
a set of default tabs 1s displayed On the Daily tab, you can see all of the appointments
and tasks planned for a given day, as shown above

Online Help 1s available in Schedule+ and 1s your primary source of information To
get help, choose Microsoft Schedule+ Help Topics from the Help menu

e OVERVIEW OF SCHEDULING APPOINTMENTS

Schedule+ displays appointments on the Daily, Weekly, and Monthly tabs, and on
other tabs mn your schedule When the user creates a new appointment, Schedule+
automatically sets a reminder for the appointment

The Schedule+ toolbar buttons make 1t easy to change an appointment to a recurring,
private, or tentative appointment If the user is not sure which button to use, position
the pointer over a toolbar button and Schedule+ will display a toolbar tip

When the user wants to schedule an appointment with another person, he/she can use
the Meeting Wizard The Meeting Wizard walks you through all the steps ot
scheduling an appointment with another person and helps schedule resources for the
meeting The user can reserve a specific time 1n his/her schedule to complete a task

e OVERVIEW OF SCHEDULING A MEETING

The user can schedule a meeting, select attendees, and send them a Meeting Request
form that invites them to attend

The easiest way to schedule a meeting is to use the Meeting Wizard

The Meeting Wizard 1s the easiest way to schedule a meeting The Meeting Wizard
automatically walks the user through the steps of scheduling a meeting by ashing
him/her a series of questions When the user fills in the answers, the Meeting Wizard
helps him/her check for conflicts on other people's schedules, mvite attendees, and
even schedule resources such as meeting rooms and computer equipment However,
the user may want to schedule a meeting on his/her own To schedule a meeting on
his/her own, follow the steps below

Step 1 Selecting meeting attendees

Step 2 Checking the availability of meeting attendees
Step 3 Selecting a meeting time

Step 4 Sending a meeting request

Step 5 Tracking responses to your meeting request

 OVERVIEW OF ADDING A CONTACT TO YOUR LIST

The Contacts tab 15 a conventent place to enter, manage, and track business and
personal contacts The user can track names, addresses, phone numbers, birthdays,
anniversaries, and other information for contacts in his/her list Schedule+ displays
this information for each contact on a series of tabs The user can add or change a
contact directly on the Contacts tab or from within the Contact dialog box
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The user can give other Schedule+ users access permission to view or modify
information 1n his/her Contacts list If the user designates a contact as private, that
contact will not be visible to other users when they view his/her list

How 1O

e TO SCHEDULE AN APPOINTMENT

Click the Daily tab

In the Date Navigator, click the day for the appomntment
Highlight the time slots for the appointment

Type a description for the appointment

Chick anywhere outside the appointment

[, S SRS T N6

To set a reminder or make the appointment recurring, private, or tentative, click the
corresponding toolbar button
The bell symbol indicates that a reminder message will appear before the
appointment
To schedule an appointment and set the reminder time, location, or other information

I Click the Daily, Weekly, Monthly, or Planner tab

2 On the Insert menu, click Appointment

You can also click the Insert New Appointment button on the toolbar

Select the date and time for the appointment

In the Description box, type a description for the appointment
Select other options for the appointment

Click OK

RN~

¢ UsING THE DATE NAVIGATOR

The Date Navigator 1s a tool that makes it easy to move quickly between days and
months When you select a date, 1t 1s surrounded by a shaded box The current date
always appears with a border surrounding 1t Days that have scheduled appointments
or meetings are shown 1n bold

h
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Using the Date Navigator, you can
* Change the date that you are viewing by clicking different calendar dates
* View the previous or following month by clicking the left or right arrow button
at the top of the calendar
* Move an appomntment from one date to another by selecting it, clicking the
border that surrounds 1t, and dragging 1t onto the new date in the Date Navigator

e TO MOVE AN APPOINTMENT TO A DIFFERENT TIME OR DATE

1 Click the appointment you want to move
2 On the Edit menu, click Move Appt

3 Select the time and date you want

4 Check OK

Another way to move an appointment to a different time or date

1 Click the appointment you want to move

2  Position the pointer over the top border of the appointment

3  When the pointer becomes a four-headed arrow, drag the appointment
to the time slot you want or to the date you want on the Date Navigator

e TO DELETE AN APPOINTMENT

1 Chick the appointment you want to delete
2  On the Edit menu, click Delete Item

You can also click the Delete button on the toolbar

e SCHEDULING MEETINGS

In Schedulet+, a meeting 1s an appointment you make with other Schedule+ users
When you schedule ameeting, you identifv the attendees, determine a meeting time,
invite the attendees, and receive their responses You can also schedule the resources
for a meeting, such as a conference room or overhead projector To view attendees'
schedules, they must be using the Microsoft Exchange Client

You can start the task from the Meeting Wizard, the Planner, or the Appointment
dialog box The first two methods for scheduling a meeting are covered below
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e USING THE MEETING WIZARD
The Meeting Wizard makes 1t easy to set up meetings by prompting you for all the
necessary information The Meeting Wizard walks you through

= Choosing required and optional attendees

» (Choosing a date, time, and location

= Choosing any resources required, such as audio-visual equipment

When the Meeting Wizard 15 fimished, a Meeting Request form opens, and you can
type an agenda or any other information about the meeting that you want attendees to
know You can also insert files or objects into the Meeting Request form When you
choose Send 1n the Meeting Request form, all the people that you have invited receive
a Meeting Request message 1n the Microsoft Exchange Client

= To start the Meeting Wizard, click the Meeting Wizard button on the toolbar

E
e USING THE PLANNER

The Planner displays your free and busy times over several days You can also use the

Planner to see other users' free and busy times When you organize a meeting, the

Planner shows busy times for users who have been invited, as well as busy locations,

so that you can easily determine a satisfactory time and place for the meeting

1 Choose the Planner tab

2 Choose Invite

3 Select the users whose schedules you want to view, and choose Required or
Optional

4 Choose OK

The busy times of users who are checked 1n the Attendees list appear as colored lines

in the Planner To check the free and busy times of just one person, clear all other

checks beside the names in the Attendees list

"'l

4| 7; Dctober136 ——7--= -
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RRYFL]
C ot |ﬁ\

Planner.

&
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5 Select the time slot you want, and then choose Request Meeting
You can also click Auto Pick under the Tools menu Schedule+ will then find the
first time slot when all attendees are available to meet

6 In the Subject box of the Meeting Request form, type a description of the meeting
The description will appear on your schedule

7 Add message text, such as a meeting agenda, or attach files as appropriate, just as
you do when sending an e-mail message

8 Click the Send button
Schedule+ automatically marks the meeting time in your Planner and places the
meeting 1n your Appointment Book

Tip

When scheduling meetings for a large group, you may find few or no open slots,
though you can determune which time slots are the least busy One technique 1s to
send the meeting request even 1f some attendees are already booked and ask those
who are booked to cancel or reschedule their other appointments You can also
expedite your planning by asking for their best alternative meeting times 1f they

cannot make the proposed time

o TO INVITE PEOPLE AND RESOURCES TO A MEETING

Click the Planner tab
Click Invite

Click the name you want to invite
Click Required or Optional

~NON D R W —

Click OK

Under Show Names From The, select the list you want

Click Resource to add a resource such as a meeting room

o TO CHECK THE AVAILABILITY OF MEETING ATTENDEES

Click the Planner tab

N —

meeting attendees

Use the following procedures to check information on the availability of

To check

Do this

The names of unavailable attendees for a
time slot

Double click the busy time slot

A description of the conflicting
appointment (only available if you have
read permission for the attendee's schedule)

Double click the busy time slot, and then
click the name of the person or resource for
which you want details

The availability of one person or resource

In the Attendees list, double click the name
of a person or resource

The availability of a group, such as all the
Required attendees

In the Attendees list, double click the
Required, Optional, or Resource heading
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TO SELECT A MEETING TIME YOURSELF

Click the Planner tab
Highlight the time slot you want for the meeting
Click Request Meeting

W N =

To have Schedule+ select an available meeting time

1 Chick the Planner tab
2 Highlight the earliest time slot from which you want to begin searching for
an available meeting time Schedule+ moves forward from that time slot to
find an available meeting time
3 On the Tools menu, click Auto Pick
4 To use the suggested time to schedule the meeting, click Request Meeting
-Or-
To have Schedulet+ look for the next available time, click Auto Pick again on the
Tools menu

e TO SEND A MEETING REQUEST

On the Planner tab, click Request Meeting

In the Subject box, type a description of the meeting

Add any other recipients, type any text, or attach any files that you want
To send the message, click Send on the File menu

B S

You can also click the Send button on the toolbar
o TO TRACK RESPONSES TO YOUR MEETING REQUEST

Click the Daily tab
Double-click the meeting
Click the Attendees tab
Chick OK

BN —

e TO ADD A CONTACT TO YOUR CONTACTS LIST

—

Click the Contacts tab
2 On the Insert menu, click Contact

You can also click the Insert New Contact button on the toolbar

—

Type the information for the contact You can move to the next area by
pressing TAB

2 Under Phone Number, select the type of phone number and then type the
number 1n the box

Click the Phone, Address, or Notes tab to add any other information

Click OK

(U8}

=N
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e TO SET THE REMINDER TIME FOR NEW APPOINTMENTS OR TASKS

On the Tools menu, click Options

Click the Defaults tab

3 If necessary, select the check box you want to automatically set reminders
for appointments or tasks

4 To change the reminder time, click the arrows to select the number you
want

5 Click the down arrow to specify minutes, hours, days, weeks, or months

6 Click OK

R =

o TO RESCHEDULE A MEETING

Click the Daily tab

Double-click the meeting

On the General tab, change the time or date for the meeting
Click OK

W) N —

o TO CANCEL A MEETING

Click the meeting
On the Edit menu, click Delete Item

N —

You can also click the Delete button on the toolbar
¢ TO GET TOOLBAR BUTTON INFORMATION

Position your mouse pointer over the button that you want information about
Schedule+ displays a ToolTip that briefly describes that button
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APPENDIX A

The following Room Numbers / Extension Numbers used in the office

Room No Workgroup Occupants User Ext
- RS Tt Name
01 Project Office Mrs Nadia Magdy Nmagdy 15
02 Court Admin Mrs ShamNoor Abdul Aziz | Snoor 13
Mr Alber Szal Aszal 14
03 Court Auto Mr Walter Kuencer Wkuencer 11
Mr Sherif Hosni Shosni 12
04 Mr Gamal Kamel Gkamel 27
05 Judicial Train Mr Samir Sultan Ssultan 28
Mrs Virginia Leaviit Vieaviit 29
06 Photocopying 31
07 MOJ Coordinator | Dr Ashraf Kamal Akamal 25
08 Conference Room 22
09 Project Office Mrs Janie Abdul Aziz Jabdulaziz 20
10 COP Mr Ronald Taylor Rtaylor 19
Reception | Project Office Ms Mona Rashwan Mrashwan 10
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AVAILABLE SOFTWARE RESOURCES

A number of software products I1s available for the AOJS members to use The
Iist includes the following resources

Software Product Name -

Quantity Available

ABC Flowchartervé 0

CorelWPv 70

Excelv70

MS Exchange Win NT

MS Office Pro (Arabic)

MS Office (Arabic)

MS Office Pro v 97 (English)

MS Publisherv4 0

Norton AntiVirusv 2 0

Norton Navigator Win95

Norton NT Tools v 10

Norton PC AnyWhere Win85

Norton Utilities v2 0

OmniPage Prov7 0

Organizer 97

PowerChutev 4 0

Project 5

Visio—~—.

Windows 95 (Pre-Installed)

Windows 95 (Arabic)

Windows NT Server 4 0

Windows NT Workstation 4 0

N~ afnafalajaalN]AalajalaloolWIN] - aalaa

M
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USER SPECIFICATION SECTION
All workstations have Microsoft Exchange, Microsoft Schedule+, and Norton

AntiVirus

User Name RTaylor
Workgroup COP

Workstation Hardware

ftem =~ . - Serial Number
IBM System Unit 23PVX14

IBM Monitor 23GK807

IBM Keyboard 0152960

IBM Mouse 139304

Workstation Software

Item . *

Serial Number

MS Windows 95

22296-OEM-0014081-42932

MS Office 97 zmglish

53491-806-1720121-00878

Lotus Organizer

1F00022-72653190

Microsoft Project

35910-271-0108426-68621
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User Name WKuencer
Workgroup Court Auto

Workstation Hardware

Item . - i Serial Number .
IBM System Unit

IBM Monittor 23X5630

IBM Keyboard 0198211

|BM Mouse 206215

Workstation Software

Item ' - -

Serial Number

MS Windows 95

19796-OEM-00133985-88168

MS Office 97 &wg/ish

53491-806-1716776-65132

Lotus Organizer

1F00022-72653190
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User Name Vleavitt
Workgroup Judicial Train

Workstation Hardware

[tem -7 Serial Number
IBM System Unit 23PVZ38

IBM Monitor 23GK390

IBM Keyboard 198209

IBM Mouse 206247

Workstation Software

Item

Serial Number

MS Windows 95

22296-0OEM-0014081-71903

MS Office 87 Enr4qlish

53481-806-1770724-29250

Lotus Organizer

1F00022-72653190

Microsoft Project

3590-056-0130962-55974
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User Name Jabdulaziz
Workgroup Project Office

Workstation Hardware

Item -- Serial Number
IBM System Unit 23PWC31

IBM Monitor 23GN693

IBM Keyboard 0198275

IBM Mouse 206243

Workstation Software

[tem

Serial Number -- -

MS Windows 95

22296-OEM-0014081-88184

MS Office 97 Ena6h

53491-806-1720623-71266

Lotus Organizer

1F00022-72653190

Microsoft Project

35910-055-0920881-77792
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User Name SSultan

Workgroup Judicial Train

Workstation Hardware

ltem ; Serial Number .
IBM System Unit 23PVY52

IBM Monitor 23GNB680

IBM Keyboard 285417

IBM Mouse 999595

Workstation Software

ltem -~

Serial Number

MS Windows 95

24264-425-0032952-62293

MS Office 95 Arabtc

40644-425-0004917-33400

Lotus Organizer

1F00022-72653190

]

07/08/97

Systems Research Egypt

Page 69



Appendices

User Name Snoor
Workgroup Court Admin

Workstation Hardware

Item. - Serial Number
IBM System Unit 23PVL94

IBM Monitor 23GK396

IBM Keyboard 97020

|BM Mouse 932180

Workstation Software

Item

Serial Number

MS Windows 95

24264-424-8014251-22808

MS Office 95  Ambjce

40644-425-0004971-77863

Lotus Organizer

1F00022-72653190
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User Name GKamel
Workgroup Project Office

Workstation Hardware

Item - | Serial Number
IBM System Unit 23PVZ884

IBM Monitor 23GN761

IBM Keyboard 93423

IBM Mouse 39229

Workstation Software

Item Serial Number
MS Windows 95 22296-OEM-0014081-88363
Excel 33611-060-0103584-84785

Lotus Organizer

1F00022-72653190

MS odHe 97 Enﬂl.sk R0CF IFFISIL

07/08/97

Systems Research Egypt

Page 71



Appendices

User Name SHosnl
Workgroup Court Auto

Workstation Hardware

Item Serial Number
IBM System Unit 23PVY55

IBM Monitor 23X5596

IBM Keyboard 198210

IBM Mouse 206217

Workstation Software

Item Senal Number -
MS Windows 95 24261-425-0032952-57466
MS Office 97 Ambic 40648-425-0026625-54661
Lotus Organizer 1F00022-72653190

I
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User Name NShaheen

Workgroup Project Office

Workstation Hardware

Item - - . - Serial Number
IBM System Unit 23PVY17

IBM Monitor 23GN719

IBM Keyboard 0159823

IBM Mouse 206281

Workstation Software

item - ' -

Serial Number

MS Windows 95

24261-442-1918324-11375

MS Office 95  Arqp, e

39043-071-0100204-70860

Lotus Organizer

1F00022-72653190
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User Name MRashwan

Workgroup Project Office

Workstation Hardware

Item oo Serial Number
IBM System Unit 23PV215

IBM Monitor 23GN813

IBM Keyboard 0198205

IBM Mouse 931366

Workstation Software

ltem

Serial Number

MS Windows 95

24264-425-0032952-98710

MS Office 95 A,

40648-425-0026625-02635

Lotus Organizer

1F00022-72653190
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User Name ASzahl
Workgroup Court Admin

Workstation Hardware

ftem . - - Serial Number .
IBM System Unit 23PVM59

IBM Monitor 23GN765

iBM Keyboard 0092051

IBM Mouse 931457

Workstation Software

Item Senal Number

MS Windows 95 22296-OEM-0014081-3331
MS Office 9% s/ & / 53491-806-1720614-80876
Lotus Organizer 1F00022-72653190

W
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SERVER SPECIFICATIONS SECTION

1 processor 200 MHz Pro

64 MB RAM

2*2 1 GB SCSI hard disk drive

1 44 3 5” floppy disk drive

2 / 8 GB backup tape 4 mm DAT SCSI
6x SCSI CD ROM Drive

Compagq Ethernet Network Card 10/100
Monitor 15"

Keyboard

Compaq Mouse

3
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